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Welcome to Rampage Trading and congratulations on your commitment to what 
we believe is one of the best trading tools you will ever use. We at Rampage 
Trading could go on and on about our 25 plus years of Wall Street experience, 
top-tier MBA educations, close relationships with Wall Street’s leading research 
analysts, Institutional traders, financial media and top fund managers. But why? 
We let the charts speak for themselves because we know what works.  
 
Rampage Trading utilizes cutting-edge technology by combining quantitative 
analysis, predictive analytics and other proprietary statistically backed formulas 
employed by top traders and fund managers to bring you the next generation of 
trading software. 
 
Over the last decade, our team began extensive research into the area of 
algorithmic/automated trading with the goal of taking a successful discretionary 
trading strategy and making it as autonomous as possible. With the help of some 
of the brightest minds on Wall Street and armed with knowledge of statistically 
based behavioral research, the Rampage Trading team was able to develop 
multi-tiered algorithms that identify significant pre-conditions in price action for 
preeminent stock moves. This program, based on aggregate algorithms, in 
combination with typical triggers for entry, risk management concepts and proper 
exit techniques, surpassed expectations and lead to the development of 
Rampage Trading.  
 
Rampage Trading’s proprietary software algorithms deliver real-time Buy and 
Sell signals on time-tested winning strategies. The software works on all markets, 
including Stocks, Futures, ETF's, Commodities, Forex, Bonds or any other freely 
traded markets. Rampage Trading is universal, and works with any time frame 
including day trading, swing trading and position trading.  

Rampage Trading targets clean, easy to see price reversal points at support and 
resistance levels carved out by the markets price action. Rampage Trading 
assists the trader in identifying trading opportunities by very clearly and 
graphically displaying color changes that correspond with changes in price, 
volume and trend. Blue is bullish (more buyers than sellers), Gold is neutral 
(price consolidation) and Red is bearish (more sellers than buyers). The price 
bars or candlesticks change colors to reflect these conditions. In an uptrend, 
there are more buyers than sellers and the price bars or candlesticks turn Blue. 
We Buy on Blue price bars or candlesticks. Gold price bars or candlesticks 
represent market indecision or price consolidation and no action is to be taken. In 
a downtrend, there are more sellers than buyers and the price bars or 
candlesticks turn Red. We Sell (Short) on Red price bars or candlesticks. Our 
software will show you precisely where the balance of buyers and sellers begins 
to shift and a change of direction becomes imminent. 
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You may also confirm each Buy or Sell (Short) signal with our proprietary trend 
algorithms represented by Blue or Red colored dots above or below price. A Blue 
dot below price represents a confirmed uptrend. A Red dot above price 
represents a confirmed downtrend. If the last trend algorithm is Blue in color and 
you receive a Buy signal, you may take the long trade. If the last trend algorithm 
is Red in color and you receive a Sell (Short) signal, you may take the Sell 
(Short) trade. You may take the trade based solely on the Buy or Sell (Short) 
signal you receive without using the trend algorithms. However, we recommend 
the Buy or Sell (Short) signal be in agreement with the last trend algorithm 
colored dot (Blue is bullish while Red is bearish). 
 

Values of our proprietary trend algorithms (Blue or Red colored dots above or 
below price) represent key support/resistance areas and are used as protection 
stops if the market turns against our position. 
 
How Does Rampage Trading Work? 

 Pick a stock, future, forex or any liquid market that you'd like to trade. 
Type in the symbol. 

 Choose your time horizon: Daily, weekly, monthly, minute, tick, range, etc. 
Whenever you see a Buy or Sell signal, you decide whether or not you 
want to enter the trade. 

 Can it really be this simple? Absolutely! 
 Of course, there are a few finer points you'll need to learn along the way, 

but this is the simplicity of our software. 

This manual will provide you with very simple yet highly profitable probability 
rules and trading examples. We recommend you clear your trading mindset and 
study the rules and charts and become familiar with our software. Rampage 
Trading can help you put money management and risk perspective into your 
trades. Let this become your system, because without a system and rules, you 
are guessing. Markets consistently react to news, fear/greed and support and 
resistance. The Rampage Trading logic is based solely on price and does not 
contain any biases or theories, but instead employs proven complex 
mathematical and statistical algorithms. The nature of these algorithms will flow 
with the trend and direction of the market. Our software is highly efficient at 
getting into any move near the preceding high or low of the market turn. 
Rampage Trading overlays on your NinjaTrader chart to let you see the direction 
of the market in a clean uncomplicated manner. 
 
Rampage Trading was designed for the novice to the experienced trader. The 
less experienced traders will have a visually pleasing color coded depiction of 
market action, while the experienced trader will make use of more complex 
patterns, divergences and the like. Rampage Trading will NEVER miss a major 
move or move of consequence. Our software will give highly accurate signals on 
any market and any time frame.  
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Rampage Trading works in any time frame as well: Daily charts, weekly charts, 
monthly charts, minute charts, tick charts or range charts. 
 
Day Trading Charts 

  

Many traders will ask the question, "What is the best time frame for day 
trading?" Let's examine the pros and cons of a higher time frame and a lower 
time frame. 
  

A lower (faster) time frame will give you more trading opportunities. Your risk will 
be smaller since the range of each bar is relatively small. You will not feel bored 
because the setups will occur quickly one after another. The risk is, of course, 
with more signals, you might be over trading. The chart might be noisy, and you 
might get a few false moves along the way. Because the chart moves faster, you 
are also forced to make quick decisions and won't have much time to think before 
pulling the trigger. 
  

A higher (slower) time frame offers less trading setups, along with less false 
signals. The range of each bar will be relatively larger and so is your risk. When 
the market is relatively quiet, you may not be able to find an optimal entry signal, 
which is not necessarily a bad thing, but you do need to have the discipline to sit 
on your hands when this occurs. Because it takes more time to form a bar, it 
grants you more time to make trading decisions. 
  

What time frame should you be trading with? We really can't tell you that. Only 
you can answer that question for yourself. Each person is different. What works 
for someone else might not work for you. The most important thing is to find a 
time frame that fits YOUR personality, trading style and risk tolerance. It’s 
important that you feel comfortable with the time frame of your choice.   
  

Day trading charts can be based upon several different criteria, with the most 
popular being time, ticks (number of trades), volume (number of contracts) and 
price range. All four types of charts use the same market information (price, 
volume, etc.), but they display the information slightly differently. 
  

Tick Charts 

Charts based upon ticks make a new price bar (or candlestick, line, etc.) every 
time a specific number of trades are completed. Popular numbers of ticks are 55 
ticks, 89 ticks, 133 ticks, 233 ticks, 500 ticks and 1000 ticks which are all short 
term timeframes. As tick based charts only make new bars when there have 
been enough trades, they adjust to the market, making bars less often when the 
market is moving slowly.  
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Explanation of Tick Charts: 

On most charts, each bar represents a period of time. 

 On a daily chart, each bar contains all the price action of that one day and 
when the next day starts, a new bar is plotted.  

 On a 5 minute chart, each bar represents all the price action for 5 minutes 
and when the 6th minute begins, the chart plots a new bar.  

“Tick” charts are different in that each bar does not represent any particular 
amount of time. A “tick” is a trade. So every time someone places a trade, that is 
called a “tick.” 

For example, a 233 tick chart, creates a bar that includes all the price action for 
233 trades. When the 234th trade goes through the market, the chart plots a new 
bar. 

 When the market is slow, it could take 5 minutes for 233 trades to go 
through the market.  

 When the market is fast, it could take 30 seconds for 233 trades to go 
through the market.  

Tick charts are a way of incorporating volume into the price bars and price 
formations themselves. 

However, remember it isn’t really measuring volume directly because trades 
(“ticks”) will have varying amounts of volume. One trade could be for a single 
contract, and another could be for 50 contracts. 

You can also plot “volume charts” in which each bar represents how many 
contracts (shares) each bar will represent rather than how many trades. 

Many traders prefer tick charts for several reasons: 

1. Tick charts tend to create more symmetrical patterns than regular minute 
charts because when the market is extremely slow, minute charts will 
continue to plot a lot of small bars that go no where. When the market is 
fast, it will create very long bars, because it can’t create a new bar until 
time is up (1, 3 and 5 minute charts, etc.).  

2. Tick charts often create more narrow range bars than minute charts at 
turning points, thus allowing traders to keep their risk smaller 
(because their risk is defined by the range of the bars at cycle turning 
points in the market).  

 



 7 

Some day traders believe that this gives tick charts an advantage over time 
charts. There is no best time frame to fit every one. It really depends on your 
personality, trading style and risk tolerance. So how do you determine what time 
frame to use for your trading? One way to find out is through back-testing and 
finding the best risk/reward ratio that you feel comfortable with. Pull up a chart 
and plot the entries and logical exits and mark them on the chart. Then calculate 
the average risk/reward ratio for that time frame. If risk control is what you desire 
and the difference between an entry signal and exit signal is too great for your 
taste, try a smaller tick count. Do so until you find a risk/reward ratio that you feel 
comfortable with.  

Time Charts 

Popular day trading time charts include 1, 3 and 5 minute charts. In markets that 
are a bit stagnant, these time sequences work well. Many traders have used time 
charts in very volatile markets with great success. In heavily traded and trending 
markets we recommend tick charts and in more stagnant, choppy and 
consolidating markets, we prefer time charts. Use the charts to practice and flip 
back and forth. You will be amazed at how the greatest set-up with a specific tick 
chart looks like when you see the same information graphed in a specific minute 
sequence. 

Again, there’s no best interval for day trading. Each has advantages and 
disadvantages, so you should evaluate them for yourself and choose an interval 
that fits your personality, trading style and risk tolerance. 

 Faster charts give you more trades per day and can lower your risk per 
trade, but at the expense of being noisy (having more meaningless and 
false moves) and requiring you to make faster decisions since the bars 
close faster, especially in fast markets.  

 The slower charts (longer time-frames) grant you more time to make 
trading decisions and have less noise, but since the point range of each 
bar is bigger, your risk per trade is larger. In addition, since they provide 
fewer trades per day, it’s easier to get lulled to sleep during long periods of 
insignificant activity.  

Range Charts 

 

Range charts have also become a popular chart setting for many traders. Charts 
based upon price range make a new price bar (or candlestick, line, etc.) every 
time the price has moved a specific distance. Popular range charts include 3, 4 
and 5 range charts. As price range based charts only make new bars when there 
has been enough price movement, they adjust to the market, creating bars less 
often when the market is stuck in a small range (i.e. not moving). Some day 
traders believe that this gives range charts an advantage over time charts. 
Range charts appear different from other types of charts, because each bar (or 
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candlestick, line, etc.) has the same range (high - low) and therefore has the 
same size when displayed on the chart. Again, you should evaluate different 
settings for yourself and choose a range that fits your personality, trading style 
and risk tolerance. 
  

Swing Trading Charts 

One of the most crucial elements of swing trading is knowing which timeframe to 
trade. There are a wide variety of timeframes that a swing trader has available to 
them. It should be of great importance then for any trader to know which 
timeframes give them that much needed trading edge. There are a lot of 
timeframes you could swing trade with, but can you get an edge by using one or 
two over others? The 30 minute, 60 minute, 2 hour, 4 hour and daily timeframes 
are a popular choice among swing traders and these timeframes are high 
enough to remove market noise but also short enough to allow you to spot and 
take advantage of trends before they change. Lower timeframes (less than the 
30 minute), are usually so low or fast that they are cluttered with market noise. 
Trading these lower timeframes successfully is difficult for anyone, especially 
someone who is still new to trading. The trend can be hard to spot because of all 
the market noise. You may also discover that trends in lower timeframes are fast 
and short lived and very difficult to swing trade. By the time you have identified 
the trend, it may have already changed and you end up trading against the new 
trend instead of with it. Swing trading higher timeframes greatly improves your 
trading edge as you are able to identify trends with much more accuracy. 

Rampage Trading works in every market, with every style of trading. It also works 
in any market condition – bull or bear. Rampage Trading was designed to trade 
directionally with the prevailing trend based upon complex mathematical and 
statistical algorithms designed by some of the brightest minds on Wall Street.  
 
Rampage Trading, in our opinion, is far superior to anything on the market. Our 
charts are easy to read and provide a true picture of what price is doing at that 
very moment. No complicated lines or wiggles, just a simple Buy or Sell arrow 
designed to provide a turning point in the market. Rampage Trading, like 
anything, requires a little practice by watching the signals unfold in real time and 
having patience to wait for trade signals and price action patterns. Rampage 
Trading will confirm what the market is saying and will provide an invaluable aid 
in the interpretation of market action.  
 
 
 
 
 
 
 
 

andrey
3-lines-1



 9 

Rampage Trading Email: info@rampagetrading.com 
 
Please read & agree with our Risk Disclosure/Disclaimer before using our 
service. 
 
http://www.rampagetrading.com/disclaimer 
 
Risk Disclosure/Disclaimer: This software is provided "as is," without any express 
or implied warranty of any kind and to be used at your own risk. The developers 
or company shall not be liable for damages of any kind from the use or reliance 
on this software. The attached indicator or trading system is intended to be used 
as guidelines and in no way constitute any advice or recommendation with 
regards to trading decisions. There are no refunds once the software is shipped 
and delivered.  
 
The risk of loss trading commodities or futures can be substantial. Commodity 
trading has large potential risks, in addition to any potential rewards. You must 
be aware of the risks and be willing to accept them in order to invest in the 
futures or commodities markets. Don't trade with money you can't afford to lose. 
This is neither a solicitation nor an offer to buy or sell commodity interests. The 
use or placement of any stop-loss or stop-limit orders may not limit your losses 
and you could lose more than your intended amount of money at risk. Past 
performance of any indicator, trading system or methodology is not indicative of 
future results.  
 
Your use of this software shall serve as your acceptance of this disclaimer and 
that you acknowledge that this indicator is licensed for your personal use only. 
The strategy, indicator and source codes remain the intellectual property of 
Rampage Trading and shall not be copied or shared without permission.  
 
Trading is considered a high-risk speculative strategy. Only risk capital should be 
used and the rigid observation of a system for loss control is strongly 
recommended. Additionally, the use of margin may dramatically increase the 
risks associated with trading. Rampage Trading make no claims whatsoever 
regarding past or future performance. Past results are no indication of future  
performance. Any trade alert is for educational purposes only. Hypothetical or 
simulated performance results have certain inherent limitations. Unlike an actual 
performance record, simulated results do not represent actual trading. Also, 
since the trades have not actually been executed, the results may have under – 
or overcompensated for the impact, if any, of certain market factors, such as lack 
of liquidity. Simulated trading programs in general are also subject to the fact  
that they are designed with the benefit of hindsight. No representation is being 
made that any account will or is likely to achieve profits or losses similar to those 
shown.  
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Software User Agreement  
 
IMPORTANT: PLEASE READ THIS AGREEMENT CAREFULLY BEFORE 
CONTINUING WITH THE INSTALLATION PROCESS OF THE SOFTWARE 
("THE SOFTWARE"). BY INSTALLING THE SOFTWARE, YOU AGREE TO BE 
BOUND BY THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO 
THE TERMS OF THIS AGREEMENT, DO NOT INSTALL THE SOFTWARE.  
 
1. License. If you have purchased a license to the Software, Rampage Trading 
grants you a nonexclusive right and license to use the Software and the related 
documentation (the "Documentation") as set forth in this Agreement. You may 
use the Software on a single computer. You may also use the Software on a 
second (portable or home) computer so long as only one copy is used at a time. 
You may make a single copy of the Software for backup and archival purposes  
only provided that any copy must contain all proprietary notices included in the 
original. You may use the Documentation to assist in your use of the Software. If 
you download the Software without physical delivery of Documentation, you may 
review the Documentation online, but you may not make further copies of the 
Documentation. You own the media on which the Software is recorded, but not 
the Software itself or any copy of it. This license is not a sale of the original or 
any copy of the Software.  
 
2. Copying, Transferring or Modifying Software. The Software contains 
copyrighted material, trade secrets and other proprietary intellectual property. 
You may not permit concurrent use of the Software unless each user has an 
applicable license. You may not permit other individuals to use the Software 
except under the terms listed above. For the purposes of protecting Rampage 
Trading trade secrets, you may not decompile, disassemble, reverse engineer or 
otherwise display the Software in human readable form. You may not modify, 
translate, rent, lease, distribute or lend the Software, and you may not sell to 
others the right to use the Software on your computer. You may not remove  
any proprietary notices or labels on the Software. You may not copy, transfer, 
transmit, sublicense or assign this license or the Software except as expressly 
permitted in this Agreement.  
 
3. Term. If you have purchased a license to the Software, this Agreement and 
license are effective from the time you accept the terms of this Agreement until 
this Agreement is terminated. You may terminate this Agreement at any time by 
destroying all copies of the Software. This Agreement will terminate immediately 
and without further notice if you fail to comply with any provision of this 
Agreement. All obligations of confidentiality and restrictions on use, and all other  
provisions that may reasonably be interpreted to survive termination of this 
Agreement, will survive termination of this Agreement for any reason. Upon 
termination, you agree to destroy all copies of the Software. If you have obtained 
an evaluation copy of the Software, and have not purchased a license to the 
Software, this Agreement and license are effective for a period of thirty (30) days  
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from the date of installation of the Software.  
 
4. Warranty Disclaimers. THE SOFTWARE AND THE DOCUMENTATION ARE  
PROVIDED "AS IS" AND WITHOUT WARRANTIES OF ANY KIND, EXPRESS,  
STATUTORY OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED  
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE AND NONINFRINGEMENT. THE ENTIRE RISK AS TO THE 
QUALITY AND PERFORMANCE OF THE SOFTWARE AND THE 
DOCUMENTATION IS WITH YOU. SHOULD THE SOFTWARE  
OR THE DOCUMENTATION PROVE DEFECTIVE, YOU (AND NOT Rampage 
Trading) ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING OR 
REPAIR. Rampage Trading DOES NOT WARRANT THAT THE FUNCTIONS 
CONTAINED IN THE SOFTWARE WILL MEET YOUR REQUIREMENTS OR 
OPERATE IN THE COMBINATION THAT YOU MAY SELECT FOR USE, THAT 
THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR 
ERROR FREE, OR THAT DEFECTS IN THE SOFTWARE WILL BE 
CORRECTED. NO ORAL OR WRITTEN STATEMENT BY Rampage Trading 
OR BY A REPRESENTATIVE OF Rampage Trading SHALL CREATE A 
WARRANTY OR INCREASE THE SCOPE OF THIS WARRANTY. 
Notwithstanding the above, you may have certain warranty rights which vary from 
state to state and which cannot be disclaimed by contract. Any warranties that by 
law survive the foregoing disclaimers shall terminate ninety (90) days from the 
date you received the Software as shown by your receipt. Some states do not 
allow limitations on how long an implied warranty lasts, so the foregoing limitation 
may not apply to you if prohibited by law.  
 
5. Limitation of Liability. YOUR SOLE REMEDIES AND Rampage Trading’s 
ENTIRE LIABILITY ARE SET FORTH ABOVE. IN NO EVENT WILL Rampage 
Trading BE LIABLE FOR DIRECT, INDIRECT, INCIDENTAL OR 
CONSEQUENTIAL DAMAGES RESULTING FROM THE USE OF THE 
SOFTWARE, THE INABILITY TO USE THE SOFTWARE, OR ANY DEFECT IN 
THE SOFTWARE, INCLUDING ANY LOST PROFITS, EVEN IF THEY HAVE 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. IN NO  
EVENT WILL Rampage Trading’s TOTAL LIABILITY TO YOU FOR ALL 
DAMAGES, LOSSES, AND CAUSES OF ACTION (WHETHER IN CONTRACT, 
TORT, INCLUDING NEGLIGENCE, OR OTHERWISE) EXCEED THE AMOUNT 
YOU PAID FOR THIS PRODUCT. SOME JURISDICTIONS DO NOT ALLOW 
THE EXCLUSION OR LIMITATION OF RELIEF, INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION 
MAY NOT APPLY TO YOU. You agree that Rampage Trading will not be liable 
for defense or indemnity with respect to any claim against you by any third party 
arising from your possession or use of the Software or the Documentation.  
 
 6. Export Control Laws. You agree to comply with all laws, rules and regulations 
applicable to the export of the Software or the Documentation. Specifically, you 
shall not export, re-export or transship the Software or the Documentation, or the 
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direct product thereof, in violation of any United States laws and regulations 
which may from time to time be applicable. None of the Software or underlying 
information or technology may be downloaded or otherwise exported or re- 
exported (i) into any country to which the U.S. has embargoed goods; or (ii) to 
anyone on the U.S. Treasury Department's list of Specially Designated Nationals 
or the U.S. Commerce Department's Table of Denial Order. By downloading or 
using the Software, you are agreeing to the foregoing and you are representing 
and warranting that you are not located in, under the control of, or a national or 
resident of any such country or on any such list.  
 
7. Government Restricted Rights. The Software has been developed at private 
expense and is "commercial computer software" or "restricted computer 
software" within the meaning of the FARs, the DFARs, and any other similar 
regulations relating to government acquisition of computer software. Nothing 
contained herein will be deemed to grant any government agency any license or  
other rights greater than are mandated by statute or regulation for commercial 
computer software developed entirely at private expense.  
 
8. Entire Agreement. This Agreement is the complete agreement between 
Rampage Trading and you and supersedes all prior agreements, oral or written, 
with respect to the subject matter hereof. If you have any questions concerning 
this Agreement, you may write to Rampage Trading, Customer Service, at 
info@rampagetrading.com. 
 
Rampage Trading is neither a solicitation nor an offer to Buy/Sell futures or 
options. No representation is being made that any account will or is likely to 
achieve profits or losses similar to those discussed on this website. The past 
performance of any trading system or methodology is not necessarily indicative 
of future results. Futures, options, and securities trading have risk of loss and 
may not be suitable for all persons.  
 
CFTC RULE 4.41 - HYPOTHETICAL OR SIMULATED PERFORMANCE RESULTS HAVE CERTAIN 
LIMITATIONS. UNLIKE AN ACTUAL PERFORMANCE RECORD, SIMULATED RESULTS DO NOT 
REPRESENT ACTUAL TRADING. ALSO, SINCE THE TRADES HAVE NOT BEEN EXECUTED, THE 
RESULTS MAY HAVE UNDER-OR-OVER COMPENSATED FOR THE IMPACT, IF ANY, OF CERTAIN 
MARKET FACTORS, SUCH AS LACK OF LIQUIDITY. SIMULATED TRADING PROGRAMS IN GENERAL 
ARE ALSO SUBJECT TO THE FACT THAT THEY ARE DESIGNED WITH THE BENEFIT OF HINDSIGHT.  

 
I have read the Risk Disclosure/Disclaimer, and I know that any trades that I 
make are my responsibility only. I fully understand that the Rampage Trading 
software is a tool to aid in my decisions. Any execution or signal generated by 
the Rampage Trading software is provided for educational purposes only. It is my 
responsibility to take trades and manage them. Any profit or loss from the use of 
the Rampage Trading software is my responsibility only. I will not hold Rampage 
Trading responsible for any trades recommended by the software. I certify that I 
have read and agree to the risk disclosure and disclaimer statements. I 
understand that no warranty or guarantee has been made to me by Rampage 
Trading.  

mailto:info@rampagetrading.com
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Trading Rules: 
 
Buy Signals: 
 

 Buy – Enter a long position upon receiving a Blue arrow (which will be 
indicated under price). You may also confirm each Buy signal with our 
proprietary trend algorithms represented by Blue colored dots below price. 
A Blue dot below price represents a confirmed uptrend. If the last trend 
algorithm is Blue in color and you receive a Buy signal, you may take the 
long trade. You may take the long trade based solely on the Buy signal 
you receive without using the trend algorithms. However, we recommend 
the Buy signal be in agreement with the last trend algorithm colored dot 
(Blue is bullish). You may also enter a long position based on the color 
change of the trend algorithm from Red to Blue provided the last arrow is 
still on a Buy signal.  

 Recommended Buy – Enter a long position on the first pullback to the 10 
period EMA (Exponential Moving Average) after a Buy signal is given. 
After receiving a Buy signal, wait for price to pullback to the 10 period 
EMA (Exponential Moving Average) or as close to it as possible before 
taking a long position. If a Buy signal is given and price is not extended 
from the 10 period EMA (Exponential Moving Average), you may take the 
trade immediately. We recommend a 10 period EMA (Exponential Moving 
Average) as your moving average. You may also confirm each Buy signal 
with our proprietary trend algorithms represented by Blue colored dots 
below price. A Blue dot below price represents a confirmed uptrend. If the 
last trend algorithm is Blue in color and you receive a Buy signal, you may 
take the long trade. You may take the trade based solely on the Buy signal 
you receive without using the trend algorithms. However, we recommend 
the Buy signal be in agreement with the last trend algorithm colored dot 
(Blue is bullish). You may also enter a long position based on the color 
change of the trend algorithm from Red to Blue provided the last arrow is 
still on a Buy signal.  

 Exit long position after the appearance of the first Red arrow (which will be 
indicated above price) or if the trend algorithm changes color (from Blue to 
Red) or if price closes below our trend algorithms (represented by 
Blue colored dots below price). Values of our trend algorithms represent 
key support/resistance areas and are used as protection stops if the 
market turns against our position.    
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Recommended Buy Signal Example: 
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Continuation Buy Example: 
 
This strategy pertains to day traders. If the last signal from the previous day is 
still on a Buy signal and our proprietary trend algorithms are also Blue in color 
(Blue dots below price represent a confirmed uptrend), wait for a pullback to the 
10 period EMA (Exponential Moving Average) or as close as possible to the 10 
period EMA (Exponential Moving Average) before initiating a long position. This 
strategy usually occurs during the first hour of the day as a pullback to the 10 
period EMA (Exponential Moving Average) is usually a good entry point before 
price resumes its uptrend. 
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Trend Algorithm Buy Example: 
 
Our proprietary trend algorithms, represented by Blue or Red colored dots above 
or below price are universal and will work on all time frames. A Blue colored dot 
(which will be indicated below price) represents a confirmed uptrend. A Red 
colored dot (which will be indicated above price) represents a confirmed 
downtrend. You cannot adjust the trend algorithms. If the last trend algorithm is 
Blue in color and you receive a Buy signal, you may take the long trade. If the 
last trend algorithm is Red in color and you receive a Sell (Short) signal, you may 
take the Sell (Short) trade. You may take trades based solely on the Buy or Sell 
(Short) signals you receive without using the trend algorithms. However, we 
recommend the Buy or Sell (Short) signals be in agreement with the last trend 
algorithm colored dot (Blue is bullish while Red is bearish). If in agreement, the 
trade will usually have a higher probability of success.  
 
You may also enter a long position based on the color change of the trend 
algorithm from Red to Blue provided the last arrow is still on a Buy signal.  
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Non-Confirmation Buy Signal Example: 
 
You may take the long trade based solely on the Buy signal you receive without 
using the trend algorithms. However, we recommend the Buy signal be in 
agreement with the last trend algorithm colored dot (Blue is bullish). 
 
You may enter a long position based on the color change of the trend algorithm 
from Red to Blue provided the last arrow is still on a Buy signal.  
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Sell Signals: 
 

 Sell – Enter a Sell (Short) position upon receiving a Red arrow (which 
will be indicated above price). You may also confirm each Sell (Short) 
signal with our proprietary trend algorithms represented by 
Red colored dots above price. A Red dot above price represents a 
confirmed downtrend. If the last trend algorithm is Red in color and you 
receive a Sell (Short) signal, you may take the Sell (Short) trade. You 
may take the Sell (Short) trade based solely on the Sell (Short) signal 
you receive without using the trend algorithms. However, we 
recommend the Sell (Short) signal be in agreement with the last trend 
algorithm colored dot (Red is bearish). You may also enter a Sell 
(Short) position based on the color change of the trend algorithm from 
Blue to Red provided the last arrow is still on a Sell (Short) signal.  

 Recommended Sell – Enter a Sell (Short) position on the first pullback 
to the 10 period EMA (Exponential Moving Average) after a Sell (Short) 
signal is given. After receiving a Sell (Short) signal, wait for price to 
pullback to the 10 period EMA (Exponential Moving Average) or as 
close to it as possible before taking a Sell (Short) position. If a Sell 
(Short) signal is given and price is not extended from the EMA 
(Exponential Moving Average), you may take the trade immediately. 
We recommend a 10 period EMA (Exponential Moving Average) as 
your moving average. You may also confirm each Sell (Short) signal 
with our proprietary trend algorithms represented by Red colored dots 
above price. A Red dot above price represents a confirmed downtrend. 
If the last trend algorithm is Red in color and you receive a Sell (Short) 
signal, you may take the Sell (Short) trade. You may take the trade 
based solely on the Sell (Short) signal you receive without using the 
trend algorithms. However, we recommend the Sell (Short) signal be in 
agreement with the last trend algorithm colored dot (Red is bearish). 
You may also enter a Sell (Short) position based on the color change 
of the trend algorithm from Blue to Red provided the last arrow is still 
on a Sell (Short) signal.   

 Exit Sell (Short) position after the appearance of the first Blue arrow 
(which will be indicated under price) or if the trend algorithm changes 
color (from Red to Blue) or if price closes above our trend algorithms 
(represented by Red colored dots above price). Values of our trend 
algorithms represent key support/resistance areas and are used as 
protection stops if the market turns against our position.   
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Recommended Sell (Short) Signal Example: 
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Continuation Sell (Short) Example: 
 
This strategy pertains to day traders. If the last signal from the previous day is 
still on a Sell (Short) signal and our proprietary trend algorithms are also Red in 
color (Red dots above price represent a confirmed downtrend), wait for a 
pullback to the 10 period EMA (Exponential Moving Average) or as close as 
possible to the 10 period EMA (Exponential Moving Average) before initiating a 
Sell (Short) position. This strategy usually occurs during the first hour of the day 
as a pullback to the 10 period EMA (Exponential Moving Average) is usually a 
good entry point before price resumes its downtrend. 
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Trend Algorithm Sell (Short) Example: 
 
Our proprietary trend algorithms, represented by Blue or Red colored dots above 
or below price are universal and will work on all time frames. A Blue colored dot 
(which will be indicated below price) represents a confirmed uptrend. A Red 
colored dot (which will be indicated above price) represents a confirmed 
downtrend. You cannot adjust the trend algorithms. If the last trend algorithm is 
Blue in color and you receive a Buy signal, you may take the long trade. If the 
last trend algorithm is Red in color and you receive a Sell (Short) signal, you may 
take the Sell (Short) trade. You may take trades based solely on the Buy or Sell 
(Short) signals you receive without using the trend algorithms. However, we 
recommend the Buy or Sell (Short) signals be in agreement with the last trend 
algorithm colored dot (Blue is bullish while Red is bearish). If in agreement, the 
trade will usually have a higher probability of success.  
 
You may also enter a Sell (Short) position based on the color change of the trend 
algorithm from Blue to Red provided the last arrow is still on a Sell (Short) signal.  
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Non-Confirmation Sell (Short) Signal Example: 
 
You may take the Sell (Short) trade based solely on the Sell (Short) signal you 
receive without using the trend algorithms. However, we recommend the Sell 
(Short) signal be in agreement with the last trend algorithm colored dot (Red is 
bearish).  
 
You may enter a Sell (Short) position based on the color change of the trend 
algorithm from Blue to Red provided the last arrow is still on a Sell (Short) signal.  
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Buy and Sell (Short) Example:  
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Multiple Trend/Time Frame Analysis 
 
Successful traders learn how to identify an underlying trend and trade around it 
accordingly. Trends can be classified as short term, intermediate and primary. 
Rampage Trading highly recommends the use of Multiple Trend/Time Frame 
Analysis when using our software. By taking the time to analyze Multiple 
Trend/Time Frame charts, traders can greatly increase their odds for a 
successful trade and minimize choppy or range bound markets. It is up to each 
individual trader to identify a Multiple Trend/Time Frame chart they are 
comfortable with.  
 
What is Multiple Trend/Time Frame Analysis? 
 
Multiple Trend/Time Frame Analysis (MTA) is the inspection of charts/trends, 
starting with the largest trends and timeframes, and working backwards down 
through successively smaller time frames to see how the smaller time frames 
and trends feed the larger time frames. When the smaller time frames are in 
agreement with the larger trends, traders can enter a trade in the direction of the 
trend with very good safety. If no trend exists, the smaller timeframes and trends 
will, at some point, build an uptrend or downtrend. 
  
When using Multiple Trend/Time Frame Analysis (MTA), the smaller trends are 
used to enter the larger trends, if a trend is available or to observe how the larger 
trends are built from the smaller time frames. If a larger trend is currently 
established on a particular market, traders would enter the trade when the 
smaller trends and time frames are in agreement with the larger trends. The 
smaller time frames confirm the continuation of the established trend.  
 
Multiple Trend/Time Frame Analysis (MTA) enables traders to identify whether or 
not a larger trend is starting or is already established. If a market is deep into its 
trend or movement, Multiple Trend/Time Frame Analysis (MTA) still works but the 
risk/reward profile of a new entry changes because the trend may be nearing the 
end of this move. However, once again, the use of Multiple Trend/Time Frame 
Analysis (MTA) will keep traders informed of this.  
  
What Multiple Trend/Time Frames should you be tracking? 
 
As a general rule, the higher trend/time frame always overrules the lower 
trend/time frame. The higher the trend/time frame, the more reliable the signal. 
As traders drill down in trend/time frame, the charts become more polluted with 
false moves and noise. Ideally, traders should analyze multiple trend/time frames 
to define the primary trend of whatever market they are trading and trade in the 
direction of the primary trend.  
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Examples of Multiple Trend/Time Frame Analysis (MTA) include: 
  

 A day trader could trade off of a 1 minute chart and use a 3, 5 or 15 
minute chart to define the primary trend. For example, if the primary trend 
(3, 5 or 15 minute chart) suggests an uptrending market, then the day 
trader will only take long positions and will not Sell (Short). Similarly, if the 
primary trend (3, 5 or 15 minute chart) suggests a downtrending market, 
then the day trader will only take Sell (Short) positions and will not take 
any long positions. 

 A swing trader, who utilizes daily charts for their decisions, could use 
weekly charts to define the primary trend. For example, if the primary 
trend (weekly chart) suggests an uptrending market, then the swing trader 
will only take long positions and will not Sell (Short). Similarly, if the 
primary trend (weekly chart) suggests a downtrending market, then the 
swing trader will only take Sell (Short) positions and will not take any long 
positions. 

 A long-term position trader could utilize weekly charts while using monthly 
charts to define the primary trend. For example, if the primary trend 
(monthly chart) suggests an uptrending market, then the position trader 
will only take long positions and will not Sell (Short). Similarly, if the 
primary trend (monthly chart) suggests a downtrending market, then the 
position trader will only take Sell (Short) positions and will not take any 
long positions. 

  
The Multiple Trend/Time Frames listed above are just examples and the 
selection of what group of Multiple Trend/Time Frames to use is unique to each 
individual trader.  
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RampageV7MTA 
 
Rampage Trading is excited to announce the release of the RampageV7MTA 
(Multiple Trend/Time Frame Analysis) Indicator. The RampageV7MTA Indicator 
works in conjunction with the RampageV7 Indicator to assist each trader in 
identifying specifically selected trend/time frames. Traders can now analyze as 
many different trend/time frames all without monitoring multiple charts. The 
RampageV7MTA Indicator allows traders to trade any market and any time frame 
with greater confidence and accuracy knowing your selected trend/time frame is 
in alignment with your trade. 
 
If the RampageV7MTA Indicator is Blue in color, the selected trend/time frame is 
bullish as the last signal for the selected trend/time frame trend is still on a Buy 
signal (Blue arrow under price). As a general rule, if the RampageV7MTA 
Indicator is Blue in color, your selected trend/time frame is on a Buy signal and 
you should only be looking to Buy. Why? Because your selected trend/time frame 
is showing an uptrending market and you are greatly increasing your probability 
of success by trading with the trend.  
 
If the RampageV7MTA Indicator is Red in color, the selected trend/time frame is 
bearish as the last signal for the selected trend/time frame is still on a Sell (Short) 
signal (Red arrow above price). As a general rule, if the RampageV7MTA 
Indicator is Red in color, your selected trend/time frame is on a Sell (Short) signal 
and you should only be looking to Sell (Short). Why? Because your selected 
trend/time frame is showing a downtrending market and you are greatly 
increasing your probability of success by trading with the trend.  
 
Selecting a Specific Trend/Time Frame: 
 
There is obviously a limit as to how many selected RampageV7MTA Indicators 
you can analyze. Keep it simple. Use at least one, but not more than two as 
adding more will be excessive. 
 
Day Trading Example: 
 

 1 minute (entry chart) - Sub Graph RampageV7MTA Indicator Settings; 3 
or 5 minute (short-term trend) and/or 15 minute (long-term trend). 

 
Swing Trading Example: 
 

 30 minute (entry chart) - Sub Graph RampageV7MTA Indicator Settings; 
Daily (short-term trend) and/or Weekly (long-term trend). 
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Position Trading Example: 
 

 Daily chart (entry chart) - Sub Graph RampageV7MTA Indicator Settings; 
Weekly (short-term trend) and/or Monthly (long-term trend). 

 
These are just a few RampageV7MTA Indicator setting examples. We highly 
recommend adjusting your RampageV7MTA Indicator setting to match your 
trading style and comfort level. Find a selected trend/time frame that works for 
you.  
 
Please note your selected RampageV7MTA Indicator setting must always be set 
to a higher time frame than your selected entry chart time frame. For example, if 
your entry chart time frame is a 1 minute chart, your selected RampageV7MTA 
Indicator setting must be set to any time frame greater than a 1 minute chart, i.e. 
2, 3, 5 minute, etc. Otherwise, the RampageV7MTA Indicator will not display.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 28 

RampageV7MTA Indicator Recommended Buy Signal Example: 
 
If the RampageV7MTA Indicator is Blue in color (Blue Is Bullish) and you receive 
a Buy signal, you may take the long trade. You may take the long trade based 
solely on the Buy signal you receive without confirmation from the 
RampageV7MTA Indicator. However, we recommend the Buy signal 
be in agreement with the RampageV7MTA Indicator (Blue Is Bullish). If in 
agreement, the trade will usually have a higher probability of success. Please 
note you must select your desired setting for the RampageV7MTA Indicator.  
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RampageV7MTA Indicator Buy Example: 
 
You may also enter a long position based on the color change of the 
RampageV7MTA Indicator from Red to Blue (Blue Is Bullish) provided the last 
signal is still on a Buy signal. 
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Non-Confirmation RampageV7MTA Indicator Buy Signal Example: 
 

You may take the long trade based solely on the Buy signal you receive without 
confirmation from the RampageV7MTA Indicator. However, we recommend the 
Buy signal be in agreement with the RampageV7MTA Indicator (Blue Is Bullish). 
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RampageV7MTA Indicator Recommended Sell (Short) Signal Example: 
 
If the RampageV7MTA Indicator is Red in color (Red Is Bearish) and you receive 
a Sell (Short) signal, you may take the Sell (Short) trade. You may take the Sell 
(Short) trade based solely on the Sell (Short) signal you receive without 
confirmation from the RampageV7MTA Indicator. However, we recommend the 
Sell (Short) signal be in agreement with the RampageV7MTA Indicator (Red Is 
Bearish). If in agreement, the trade will usually have a higher probability of 
success. Please note you must select your desired setting for the 
RampageV7MTA Indicator. 
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RampageV7MTA Indicator Sell (Short) Example: 
 
You may also enter a Sell (Short) position based on the color change of the 
RampageV7MTA Indicator from Blue to Red (Red Is Bearish) provided the last 
signal is still on a Sell (Short) signal. 
 

 
 
 



 33 

Non-Confirmation RampageV7MTA Indicator Sell (Short) Signal Example: 
 

You may take the Sell (Short) trade based solely on the Sell (Short) signal you 
receive without confirmation from the RampageV7MTA Indicator. However, we 
recommend the Sell (Short) signal be in agreement with the RampageV7MTA 
Indicator (Red Is Bearish). 
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Installing the RampageV7MTA Indicator: 
 
After opening your chart, you can apply the newly installed RampageV7MTA 
Indicator by right-clicking the chart and selecting indicators or simply pressing the 
CTRL + I combination. You can find the newly installed RampageV7MTA 
Indicator at the top of the indicator list in the newly opened indicators window. 
You will see the name ‘RampageV7MTA.” 
 
Double click on the Indicator's name “RampageV7MTA” to add it to the lower left 
area of the Indicators window. Under “Parameters” select the “Time Frame Type” 
you wish to analyze, i.e. Tick, Range, Minute, etc. Next, select the “Time Frame 
Value” for the “Time Frame Type” you wish to analyze. For example, if you 
selected Tick and you would like to analyze a 500 Tick chart, input the number 
500 in the “Time Frame Value” field. If you selected Minute and you would like to 
analyze a 3 minute chart, input the number 3 in the “Time Frame Value” field. 
Please leave all other settings as they are. After finishing, click “Apply”, then 
“OK.”  
 
For more information on setting up and using the RampageV7MTA Indicator, 
please visit our “Members” section on our website: 
 
http://www.rampagetrading.com/members 
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RVOL (Rampage Volume) 
 
Rampage Trading is excited to announce the release of our Institutional grade 
volume analysis indicator. RVOL (Rampage Volume) will revolutionize the trading 
industry forever. Until now, this indicator was only available to our Institutional 
clients. 
  

You will never trade the same again as RVOL will allow you to stay on the same 
side as the Institutions. 
  

The RVOL indicator alone retails for thousands of dollars but we are 
exclusively offering it to our retail clients FREE as part of their 
subscription. 
  
How would your trading change if you knew what the Institutional traders knew? 
When the trends were going to start? What direction they were most likely to 
move? When those trends were most likely to stall out into consolidation? 
  
Professional traders know the importance of NEVER doing the opposite of what 
Institutional traders are doing. That's because the market moves in the same 
direction that Institutional traders are moving in.   

When Institutional traders are in accumulation mode, the market goes UP.   
When Institutional traders are in distribution mode, the market goes DOWN. 

Institutional traders are those who trade on behalf of others and include hedge 
funds, investment banks, brokerage firms, commercial banks, mutual funds, 
pension funds, insurance companies and large investment advisory firms. They 
trade large blocks of shares and therefore, command a better price and literally 
move the market. An individual investor selling a small number of shares has no 
influence on the market compared to Institutional traders looking to move 
hundreds of thousands or millions of shares through high frequency trading, 
algorithms, flash orders and dark pools. 
  
It’s impossible for big Institutional traders to buy or sell the market with size 
without RVOL targeting their activity. To give you an idea of just how big 
Institutional trader buying is, consider the following: If a single fund has $1 billion 
in assets and wants just a 2% new position in the market, it must invest $20 
million. Funds are just like elephants jumping into a bathtub. They are simply so 
big the water rises and splashes all over the place. RVOL now enables you to 
easily track the Institutional elephants and identify whether the market is being 
bought or sold:  
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* When the RVOL bar is Blue, Institutional traders are in accumulation mode and 
the market goes UP...plain and simple. 

* When the RVOL bar is Red, Institutional traders are in distribution mode and 
the market goes DOWN...plain and simple. 

* When the RVOL bar is Gold, Institutional traders represent a neutral amount of 
buying and selling. 

VOLUME is the only leading indicator which reveals true market intent, before it 
happens. All other indicators are lagged, and will tell you what has already 
happened. It’s like driving a car using just the rear view mirror.  

One of the questions many traders ask when first presented with this powerful 
concept is whether volume leads price, or does price lead volume? The simple 
answer: Volume leads price. This is why RVOL is so powerful as it tells us in 
advance, what the market is likely to do next. In simple terms, volume signals a 
price change BEFORE it happens, and this is the power of the VOLUME PRICE 
relationship. 

The RVOL indicator is a unique algorithm which performs hundreds of complex 
algorithm calculations per bar and works in tandem with the Rampage Trading 
software to tell you where the market is going next.  

There are two rules to use with the RVOL indicator before entering a new 
position. 

RVOL (Rampage Volume) Rules: 

RULE ONE: Only enter a long position following a Blue volume bar and a short 
position following a Red volume bar provided the Rampage software is also 
confirming your position. 

RULE TWO: The volume bar should be the same color as the Rampage 
software price bar. A Blue volume bar and a Blue price bar confirms a long entry 
while a Red volume bar and a Red price bar confirms a short entry. 

There are no user inputs to this indicator. 
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Installing the RVOL (Rampage Volume) Indicator: 
 
After opening your chart, you can apply the newly installed RVOL (Rampage 
Volume) Indicator by right-clicking the chart and selecting indicators or simply 
pressing the CTRL + I combination. You can find the newly installed RVOL 
(Rampage Volume) Indicator at the top of the indicator list in the newly opened 
indicators window. You will see the name “RVOL.” 
 
Double click on the Indicator's name “RVOL” to add it to the lower left area of the 
Indicators window. There are no user inputs to this indicator. After finishing, click 
“Apply”, then “OK.”  
 
For more information on setting up and using the RVOL (Rampage Volume) 
indicator, please visit our “Members” section on our website: 
 
http://www.rampagetrading.com/members 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.rampagetrading.com/members
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Rampage Trading Alerts 
 
Rampage Trading offers advanced alerting systems offered to our clients who 
wish to receive real-time RampageV7 Buy or Sell (Short) signal alerts. Rampage 
Trading automatically monitors and scans your selected markets, looking for 
signals and automatically alerts you by email or audio as soon as the 
RampageV7 Indicator recognizes a change in trend and generates a Buy or Sell 
(Short) signal for your selected time frame chart. You’ll never miss a trade again.  
 
Selecting Alerts: 
 
Email Alerts: 
 
You can choose to receive email alerts as soon as the RampageV7 Indicator 
recognizes a change in trend and generates a Buy or Sell (Short) signal for your 
selected time frame chart. 
 
Email Alerts Q&A 
 
After adding the RampageV7 indicator to my chart, how do I receive emails when 
a Buy or Sell (Short) signal appears? 
 
By default, email alerts are turned off. Follow these steps to enable 
email alerts: 
 
1. Select the specific time frame chart you wish to receive email alerts on. 
2. Open the “Indicators” dialog box by clicking on “Indicators” in the top menu or 
by right-clicking the chart and selecting “Indicators.” Scroll down the Indicator list 
and look for the RampageV7 Indicator. You will see the name “RampageV7.” 
3. Double click on the Indicator's name “RampageV7” to add it to the lower left 
area of the Indicators window. Under “Parameters” add your desired email in the 
email address field. 
4. Click “Apply” then “OK.” 
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As soon as the RampageV7 Indicator recognizes a change in trend and 
generates a Buy or Sell (Short) signal for your selected time frame chart, your 
email alert will look like this: 
 
11/10/2011 10:01:27 AM ES 12-11 Long 
 
Or 
 
11/10/2011 10:02:45 AM ES 12-11 Short 
 
In order to receive email alerts for your selected time frame chart, NinjaTrader 
and your selected time frame chart must be open and connected to a live 
datafeed. 
 
Audio Alerts Q&A 

 
After adding the RampageV7 Indicator to my chart, how do I enable audio alerts? 
 
By default, audio alerts are turned on. Follow these steps to enable 
audio alerts: 
 
1. Select the specific time chart you wish to receive audio alerts on. 
2. Open the “Indicators” dialog box by clicking on “Indicators” in the top menu. 
3. Go to “Parameters” and change “Enable Sound Alert” to “True.” 
4. Select your desired “Sound File Name.” You may select any sound file of your 
choice from the dropdown list. 
5. Click “Apply” then “Close.” 
 

 
 
You will hear your selected audio alert as soon as the RampageV7 Indicator 
recognizes a change in trend and generates a Buy or Sell (Short) signal for your 
selected time frame chart. 
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Market Analyzer Q&A 
 
How do I enable NinjaTrader Market Analyzer alerts? 
 
Follow these steps to enable NinjaTrader Market Analyzer alerts: 
 
1. Go to Control Center > File > New > Market Analyzer. 
2. You may right-click anywhere in the Market Analyzer box and select “Add 
Instrument” or “Add Instrument List.” 
3. Once you have completed adding your selected instruments, you may right 
click on the Market Analyzer box again and select “Columns.” 
4. Select “RampageV7MA” then select “New” to add it to the lower left hand 
corner box.  
5. Under “Data Series” select your desired “Type” from the dropdown list. Select 
your desired “Value.” 
6. Under “Alert” select “True” to “Enable Sound Alert.” Select desired “Sound File 
Name” from the dropdown list. Input desired “Email” to receive email alerts. 
7. Click “Apply” then “OK.” 
 

 
 
For more information on setting up and using the NinjaTrader Market Analyzer, 
please visit www.ninjatrader.com 

http://www.ninjatrader.com/
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RS (Rampage Scalper) 

 

Rampage Trading is excited to announce the release of our Institutional grade 
RS (Rampage Scalper) indicator. The RS indicator will revolutionize the trading 
industry forever and is already the buzz among global Institutional trading desks. 
Until now, this indicator was only available to our Institutional clients. 
 
The RS indicator alone retails for thousands of dollars. However, as part of 
our client loyalty program, we are exclusively offering it to our retail clients 
FREE as part of their subscription. 

What is the RS (Rampage Scalper) indicator? 

The RS indicator is a standalone HFT (High Frequency Trading) program 
designed for short term arbitrage trading. However, it is equally effective for 
swing and longer term trading. The RS indicator separately tracks Algorithmic 
trading and Dark Pool activity and reads the tape in several different ways to 
identify specific reversals and will pinpoint exactly when the large Institutions are 
selling into the highs or buying into the lows. By separating out Algos and Dark 
Pool trades, the RS indicator can obtain greater insight into the character of trade 
flow. Many Institutional portfolios utilize Dark Pool venues so that they can utilize 
the increased liquidity and privacy needed to accommodate their large 
transactions.   

In real-time, the RS indicator determines where tradable market tops or bottoms 
are most likely to occur with an extremely high level of accuracy. The RS 
indicator plots Blue and Red colored dots indicating when a market top or bottom 
is due. A Blue colored dot below price is indicative of a potential market bottom 
while a Red colored dot above price is indicative of a potential market top. 

Developed by our team of former Institutional traders and Quantitative Analysts 
(Quants), the RS indicator is one of the most mathematically intensive algorithms 
we have ever released.  

The RS indicator eliminates choppy or range bound markets by only exploiting 
ideal trading setups with a high probability of success. 

The RS indicator works on all markets and all time frames. Trade Stocks, 
Futures, ETF's, Commodities, Forex, Bonds or any other freely traded markets. 

Watch these brief videos to learn more about the RS indicator. 

http://screencast.com/t/HIPBE1qHGFbv 

http://screencast.com/t/ZM2jViG3 
 

http://screencast.com/t/HIPBE1qHGFbv
http://screencast.com/t/ZM2jViG3
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For more information on setting up and using the RS (Rampage Scalper) 
indicator, please visit our “Members” section on our website: 
 
http://www.rampagetrading.com/members 

If you are a current client, please re-download our software using your 
registration email and active license key. You will see the RS indicator included 
in the Ninja Trader indicator list.  

If you are not a current client, you may subscribe to the RS indicator using the 
following link to take your trading to the next level. 

http://www.rampagetrading.com/purchase 

RS (Rampage Scalper) Trading Rules:  
 
The RS indicator allows you to select from two different settings: 
 

1. RA (Rampage Aggressive) – This setting will present frequent trading 
setups and is suited for the aggressive trader. The risk is, with more 
signals, you might be over trading. The chart might be noisy and you 
might get a few false signals along the way. Please view our videos on 
our “Members” page for additional details. 

2. RC (Rampage Conservative) - This setting will present fewer trading 
setups than the RA setting along with less false signals. When the market 
is relatively quiet, you may not be able to find an optimal entry signal, 
which is not necessarily a bad thing. However, you do need to have the 
discipline to sit on your hands when this occurs. Please view our videos 
on our “Members” page for additional details. 

What setting should you be trading with? Only you can answer that question for 
yourself. Each trader is different and what works for someone else may not work 
for you. The most important thing is to find a setting that fits YOUR personality, 
trading style and risk tolerance. It’s important that you feel comfortable with the 
setting of your choice. Pull up any chart and review past signals for each setting. 
If risk control is what you desire and the difference between an entry signal and 
exit signal is too great for your taste, try a smaller chart setting. Do so until you 
find a risk/reward ratio that you feel comfortable with. Please see suggested 
trading times/settings below. 

 
 
 
 
 
 

http://www.rampagetrading.com/members
http://www.rampagetrading.com/purchase
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Buy Signals: 
 
Buy – Enter a long position upon receiving a Blue dot (which will be indicated 
under price). 
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Scaling Buy - If price continues to move lower after your original entry price or 
when the closing price is less than the previous entry price or upon receiving 
another Blue dot, you may enter another long position. This method is known as 
scaling in, which allows us to increase our position size and lower our average 
purchase price as the trade becomes more attractive. This rule vastly improves 
our odds of having a profitable trade by increasing our position size and lowering 
our average purchase price as the market price continues to move lower.  
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When using a strategy that utilizes scaling, we choose the ratio of the number of 
shares ahead of time so that we can plan accordingly.  
 
Let’s assume the following ratios when utilizing a scaling strategy: 1/2/3/4/5 
 
In each case, the first number represents the initial number of shares. Each of 
the subsequent numbers represents the relative size of the scale-ins which may 
or may not occur, depending on the price action of the instrument. Let’s look at a 
couple of examples: 
 
In the first example, we will use 1/1 scaling. Let’s assume that we purchase 300 
shares of a stock for $20/share. That’s our initial position. Two days later, the 
price of the stock falls to $19/share. 1/1 scaling tells us that the first scale-in (i.e. 
the second entry) should be the same number of shares as the initial 
entry, so we buy 300 more shares of the stock. Our average price per share is 
now: [(300 x $20) + (300 x $19)] / 600 = $19.50/share. Since we decided ahead 
of time that we would use 1/1 scaling, we will not buy any more shares, 
regardless of what happens to the price of the stock. 
 
For the second example, we will use 1/2/3/4 scaling. Let’s assume that our initial 
position consists of 100 shares at $30/share. The next day, the price of the stock 
closes at $29/share. With 1/2/3/4 scaling, the first scale-in (second entry) should 
be two times the number of shares in the initial position, so we purchase an 
additional 100 x 2 = 200 shares of the stock. We now own a total of 300 shares, 
and our average price per share is: [(100 x $30) + (200 x $29)] / 300 = $29.33. 
Three days later, the price drops again, to $28/share. Our next scale-in should be 
three times the number of shares in the original position, so we would buy 300 
shares at $28/share. Our average price for the 600 shares that we now own is: 
[(100 x $30) + (200 x $29) + (300 x $28)] / 600 = $28.67. On the next day, the 
price rises sufficiently to trigger our exit signal, so we exit the trade without ever 
using the final scale-in. 
 
There is one more aspect of scaling in to consider before we leave this topic. 
From a capital management perspective, it’s usually best to assume that every 
position you take will use all available scale-in positions. For example, if your 
overall portfolio allocations dictate that you can invest $5000 in 
each stock trade and you’re using 1/1 scaling, then you know that you will have 
at most 2 entries (initial plus one scale in) of approximately equal size. Therefore, 
you should invest approximately $2500 in the initial position. Your scale-in 
position will be slightly less than $2500, because you will be purchasing the 
same number of shares at a lower price. 
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Exit long position after the appearance of the first Blue X (which will be indicated 
below price).  
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Sell Signals: 

Sell – Enter a Sell (Short) position upon receiving a Red dot (which will be 
indicated above price).  
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Scaling Sell (Short) - If price continues to move higher after your original entry 
price or when the closing price is higher than the previous entry price or upon 
receiving another Red dot, you may enter another Sell (Short) position. This 
method is known as scaling in, which allows us to increase our position size and 
better our average purchase price as the trade becomes more attractive. This 
rule vastly improves our odds of having a profitable trade by increasing our 
position size and better our average purchase price as the market price 
continues to move higher. See ratio rules above. 
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Exit Sell (Short) position after the appearance of the first Red X (which will be 
indicated above price).  
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RS (Rampage Scalper) Trading Tips:  
 

 Do not take a Buy or Sell (Short) signal on a gap up or gap down in price. 
We suggest waiting for the next price bar to print a Buy or Sell (Short) 
signal (Blue or Red dot) before initiating a position. 
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 The RS indicator works on all time frames. However, due to the 
quantitative structure and character of each markets Institutional trade 
flow, we suggest the following timeframes: 

Suggested day trading time charts include 1, 2, 3 and 5 minute charts. A faster 
time frame will present frequent trading setups. Your risk will be smaller since the 
range of each bar is relatively small. The risk is, with more signals, you might be 
over trading. The chart might be noisy and you might get a few false signals 
along the way. Because the chart moves faster, you are also forced to make 
quick decisions and won't have much time to think before pulling the trigger. 
 
Suggested swing trading and position trading time charts include Daily and 
Weekly charts. A slower time frame will present fewer trading setups than a 
faster time frame, along with less false signals. The range of each bar will be 
relatively larger and so is your risk. When the market is relatively quiet, you may 
not be able to find an optimal entry signal, which is not necessarily a bad thing. 
However, you do need to have the discipline to sit on your hands when this 
occurs. Because it takes more time to form a bar, it grants you more time to 
make trading decisions. 
 
Day trading charts can be based upon several different criteria, with the most 
popular being time, ticks (number of trades), volume (number of contracts) and 
range. All these types of charts use the same market information (price, volume, 
etc.), but they display the information slightly differently. Again, there’s no best 
interval for day trading. Each has advantages and disadvantages, so you should 
evaluate them for yourself and choose an interval that fits your personality, 
trading style and risk tolerance.  
 
The RS indicator provides a well-defined exit method. Few indicators or 
strategies have quantified, structured, and disciplined exit rules. The RS indicator 
gives you the exact parameters to exit the trade which are backed by over ten 
years of historical test results. What we have found is that stops tend to lessen 
performance and in many cases they completely remove edges and our research 
which is backed by up to a decade of test results suggests that stops get hit often 
and accumulate many losses. Few trading strategies can overcome these 
aggregated losses. For many traders stops are a must. Psychologically it allows 
them to take trades, especially difficult trades. Whether you use them or not is a 
personal choice only you can make for yourself.  We know successful traders in 
both camps. As we state above, pull up any chart and review past signals for 
each setting. If risk control is what you desire and the difference between an 
entry signal and exit signal is too great for your taste, try a smaller chart setting. 
 
 
 
 
 



 54 

Installing the RS (Rampage Scalper) Indicator: 
 
After opening your chart, you can apply the newly installed RS (Rampage 
Scalper) Indicator by right-clicking the chart and selecting indicators or simply 
pressing the CTRL + I combination. You can find the newly installed RS 
(Rampage Scalper) Indicator in the indicator list in the newly opened indicators 
window. You will see the name “RS.” 
 
Double click on the Indicator's name “RS” to add it to the lower left area of the 
Indicators window. There are no user inputs to this indicator. After finishing, click 
“Apply”, then “OK.”  
 
For more information on setting up and using the RS (Rampage Scalper) 
Indicator, please visit our “Members” section on our website: 
 
http://www.rampagetrading.com/members 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.rampagetrading.com/members
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Rampage Trading RS Alerts 
 
Rampage Trading offers advanced alerting systems offered to our clients who 
wish to receive real-time RS Buy or Sell (Short) signal alerts. Rampage Trading 
automatically monitors and scans your selected markets, looking for signals and 
automatically alerts you by audio as soon as the RS Indicator recognizes a 
change in trend and generates a Buy or Sell (Short) signal for your selected time 
frame chart. You’ll never miss a trade again.  
 
Selecting Alerts: 
 
Audio Alerts: 
 
After adding the RS indicator to my chart, how do I enable audio alerts? 
 
By default, audio alerts are turned on. Follow these steps to enable 
audio alerts: 
 
1. Select the specific time chart you wish to receive audio alerts on. 
2. Open the “Indicators” dialog box by clicking on “Indicators” in the top menu. 
3. Select the RS indicator. 
4. Go to “Alerts” and change “AlertsSound” to “True.” 
5. Select your desired “AlertsSoundFile.” You may select any sound file of your 
choice from the dropdown list. 
6. Click “Apply” then “Close.” 
 

 
 
You will hear your selected audio alert as soon as the RS indicator recognizes a 
change in trend and generates a Buy or Sell (Short) signal for your selected time 
frame chart. 
 
In order to receive audio alerts for your selected time frame chart, NinjaTrader 
and your selected time frame chart must be open and connected to a live 
datafeed. 
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Market Analyzer Q&A 
 
How do I enable NinjaTrader Market Analyzer alerts? 
 
Follow these steps to enable NinjaTrader Market Analyzer alerts: 
 
1. Go to Control Center > File > New > Market Analyzer. 
2. You may right-click anywhere in the Market Analyzer box and select “Add 
Instrument” or “Add Instrument List.” 
3. Once you have completed adding your selected instruments, you may right 
click on the Market Analyzer box again and select “Columns.” 
4. Select “RSMA” then select “New” to add it to the lower left hand corner box.  
5. Under “Data Series” select your desired “Type” from the dropdown list. Select 
your desired “Value.” 
6. Under “Alert” select “True” to “Enable Sound Alert.” Select desired “Sound File 
Name” from the dropdown list. Input desired “Email” to receive email alerts. 
7. Under “Special” select your desired settings for the “Alert,” “Cell,” and “Filter” 
conditions fields. 
8. Click “Apply” then “OK.” 
 

 
 
For more information on setting up and using the NinjaTrader Market Analyzer, 
please visit www.ninjatrader.com 

http://www.ninjatrader.com/
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Trading Risk and Money Management   

Money management is one of, if not the most critical components of any 
successful trading plan. Yet, it's something that many traders overlook. If you fail 
to properly manage your risk, your odds of making money over the long term are 
greatly diminished. Depending upon what type of instrument you’re trading, and 
what trading style you have, proper money management techniques can vary 
quite a bit. Money management techniques can include asset allocation, stops 
and trailing stops, position sizing, profit taking strategies, etc. Whatever 
techniques you employ, the first step you need to take is to create an overall 
trading plan and an exit strategy for each trade. You cannot control the markets 
but you can control your money and your risk on each and every trade that you 
make. William O' Neill, founder of Investors Business Daily, has said that, "The 
whole secret to winning in the stock market is to lose the least amount possible 
when you're not right." We would agree with that! 

This section is one of the most important sections you will ever read about 
trading. Why is it important? Well, we are in the business of making money and 
in order to make money we have to learn how to manage risk (potential losses). 
Ironically, this is one of the most overlooked areas in trading. Many traders are 
just anxious to get right into trading with no regard for their total account size. 
They simply determine how much they can stomach to lose in a single trade and 
hit the "trade" button. There's a term for this type of investing and it’s called 
gambling. 

When you trade without money management rules, you are in fact gambling.  
You are not looking at the long term return on your investment. Instead you are 
only looking for that "jackpot." Money management rules will not only protect you 
but they can make you very profitable in the long run. If you don't believe us and 
you think that gambling is the way to get rich, then consider this example: People 
go to Las Vegas all the time to gamble their money in hopes of winning a big 
jackpot and in fact, many people do win. So how in the world are casinos still 
making money if many individuals are winning jackpots? The answer is that while 
even though people win jackpots, in the long run, casinos are still profitable 
because they rake in more money from the people that don't win. That is where 
the term "the house always wins" comes from.  

The truth is that casinos are just very rich statisticians. They know that in the long 
run, they will be the ones making the money, not the gamblers. Even if John Doe 
wins $100,000 jackpot in a slot machine, the casinos know that there will be 
hundreds of other gamblers who WON'T win that jackpot and the money will go 
right back in their pockets. This is a classic example of how statisticians make 
money over gamblers. Even though both lose money, the statistician or casino in 
this case, knows how to control their losses. Essentially, this is how money 
management works. If you learn how to control your losses, you will have a 
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chance at being profitable. You want to be the rich statistician and not the 
gambler because, in the long run, you want to "always be the winner."  

Capitalization 

It takes money to make money. Everyone knows that, but how much does one 
need to get started in trading? The answer largely depends on how you are going 
to approach your new start-up business. You need money/capital/funds to trade. 
Retail brokers offer minimum account deposits as low as $500, but that doesn't 
mean you should enter immediately! This is a capitalization mistake, which often 
leads to failure. Losses are part of the game, and you need to have enough 
capital to weather these losses.  

So how much capital do you need? Let's be honest here, if you're consistent and 
you practice proper money management techniques, then you can probably start 
off with $25k to $100k in trading capital. It's common knowledge that most 
businesses fail due to undercapitalization, which is especially true in the trading 
business.  So if you are unable to start with a large amount that you can afford to 
lose, be patient, save up and learn to trade the right way until you are financially 
ready. 

Drawdown and Maximum Drawdown 

We know that money management will make us money in the long run, but now 
we'd like to show you the other side of things. What would happen if you didn't 
use money management rules? Consider this example:  

Let's say you have a $100,000 and you lose $50,000. What percentage of your 
account have you lost?  

The answer is 50%.  

Simple enough.  

This is what traders call a drawdown. A drawdown is the reduction of one's 
capital after a series of losing trades. This is normally calculated by getting the 
difference between a relative peak in equity capital minus a relative trough. 
Traders normally note this drawdown as a percentage of their trading account.  In 
trading, we are always looking for an edge. A trading system that is 70% 
profitable sounds like a very good edge to have. But just because your trading 
system is 70% profitable, does that mean for every 100 trades you make, you will 
win 7 out of every 10? Not necessarily! How do you know which 70 out of those 
100 trades will be winners? The answer is that you don't. You could lose the first 
30 trades in a row and win the remaining 70. That would still give you a 70% 
profitable system, but you have to ask yourself, "Would you still be in the game if 
you lost 30 trades in a row?"  This is why money management is so important. 
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No matter what system you use, you will eventually have a losing streak. Even 
professional poker players who make their living through poker go through 
horrible losing streaks, and yet they still end up profitable. The reason is that the 
good poker players practice money management because they know that they 
will not win every tournament they play. Instead, they only risk a small 
percentage of their total bankroll so that they can survive those losing streaks. 
This is what you must do as a trader. Drawdown’s are part of trading. The key to 
being a successful trader is coming up with trading plan that enables you to 
withstand these periods of large losses. And part of your trading plan is having 
risk management rules in place.  Only risk a small percentage of your trading 
bankroll so that you can survive your losing streaks. Remember that if you 
practice strict money management rules, you will become the casino and in the 
long run, "you will always win." 

In the next section, we will illustrate what happens when you use proper money 
management and when you don't. 

Here is a little illustration that will show you the difference between risking a small 
percentage of your capital compared to risking a higher percentage. 

 

 

 

 

 

 

 

 

 

 

 

 

 



 60 

Trader Risks 2% vs. 10% on Each Trade 

Trade 
# 

Total 
Account 

2% risk on 
each trade 

Trade 
# 

Total 
Account 

10% risk on 
each trade 

1 $20,000 $400 1 $20,000 $2,000 

2 $19,600 $392 2 $18,000 $1,800 

3 $19,208 $384 3 $16,200 $1,620 

4 $18,824 $376 4 $14,580 $1,458 

5 $18,447 $369 5 $13,122 $1,312 

6 $18,078 $362 6 $11,810 $1,181 

7 $17,717 $354 7 $10,629 $1,063 

8 $17,363 $347 8 $9,566 $957 

9 $17,015 $340 9 $8,609 $861 

10 $16,675 $333 10 $7,748 $775 

11 $16,341 $327 11 $6,974 $697 

12 $16,015 $320 12 $6,276 $628 

13 $15,694 $314 13 $5,649 $565 

14 $15,380 $308 14 $5,084 $508 

15 $15,073 $301 15 $4,575 $458 

16 $14,771 $295 16 $4,118 $412 

17 $14,476 $290 17 $3,706 $371 

18 $14,186 $284 18 $3,335 $334 

19 $13,903 $278 19 $3,002 $300 

You can see that there is a big difference between risking 2% of your account 
compared to risking 10% of your account on a single trade. If you happened to 
go through a losing streak and lost only 19 trades in a row, you would've went 
from starting with $20,000 to having only $3,002 left if you risked 10% on each 
trade. You would've lost over 85% of your account! If you risked only 2% you 
would've still had $13,903 which is only a 30% loss of your total account. 

Of course, the last thing we want to do is to lose 19 trades in a row, but even if 
you only lost 5 trades in a row, look at the difference between risking 2% and 
10%. If you risked 2% you would still have $18,447. If you risked 10% you would 
only have $13,122. That's less than what you would've had even if you lost all 19 
trades and risked only 2% of your account! The point of this illustration is that you 
want to setup your money management rules so that when you do have a 
drawdown period, you will still have enough capital to stay in the game. Can you 
imagine if you lost 85% of your account? You would have to make 566% on what 
you are left with in order to get back to break even. 
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Here is a chart that will illustrate what percentage you would have to make to 
breakeven if you were to lose a certain percentage of your account. 

Loss of Capital % Required to get back to breakeven 

10% 11% 

20% 25% 

30% 43% 

40% 67% 

50% 100% 

60% 150% 

70% 233% 

80% 400% 

90% 900% 

You can see that the more you lose, the harder it is to make it back to your 
original account size. This is all the more reason that you should do everything 
you can to protect your account. By now, we hope you understand that you 
should only risk a small percentage of your account in each trade so that you can 
survive your losing streaks and also to avoid a large drawdown in your account. 
Remember, you want to be the casino and not the gambler. 

Reward-to-Risk Ratio 

Another way you can increase your chances of profitability is to trade when you 
have the potential to make 3 times more than you are risking. If you give yourself 
a 3:1 reward-to-risk ratio, you have a significantly greater chance of ending up 
profitable in the long run. Take a look at this chart as an example: 

10 Trades Loss Win 

1 $1,000   

2   $3,000 

3 $1,000   

4   $3,000 

5 $1,000   

6   $3,000 

7 $1,000   

8   $3,000 

9 $1,000   

10   $3,000 

Total $5,000 $15,000 
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In this example, you can see that even if you only won 50% of your trades, you 
would still make a profit of $10,000. Just remember that whenever you trade with 
a good risk to reward ratio, your chances of being profitable are much greater 
even if you have a lower win percentage. 

Be the casino, not the gambler!  

Remember, casinos are just very rich statisticians! Drawdown’s are a reality and 
WILL happen to you at some point. The more you lose, the harder it is to make it 
back to your original account size. This is all the more reason that you should do 
everything you can to protect your account. We hope that you have gotten it 
drilled in your head that you should only risk a small percentage of your account 
in each trade so that you can survive your losing streaks and also to avoid a 
large drawdown in your account. The less you risk in a trade, the less your 
maximum drawdown will be. The more you lose in your account, the harder it is 
to make it back to breakeven. This means you should only trade only a small 
percentage of your account. The smaller the better.  

Setting Stops 

This is probably one of the most debated subjects among traders. Some traders 
will argue that you shouldn't use stop loss orders when trading. There are some 
negatives to stop orders, such as exposing yourself to being "run." If you've ever 
set a stop order and had the stock drop, stop you out, and then rebound in a 
short period of time, your were "run." Another argument against stops is that by 
placing the stop you are guaranteeing that, should your trade move in the wrong 
direction, you will end up selling at lower prices, not higher. If you are unsure 
about the position, then why not just bite the bullet and Sell instead of waiting for 
a decline to take you out of the trade? Both are valid arguments, but we still feel 
that most traders are better off using stop loss orders to protect themselves. 

In spite of the negatives, a stop loss is important because it can prevent a small 
loss from becoming a disastrously large one. What's more, by diligently setting 
stop losses whenever you enter a trade, you end up making this important 
decision at the point in time when you are most objective about what is really 
happening with the stock. Your stops should have been set at a time when you 
are most objective about the possible outcomes of your trade. Once the stock 
starts moving, you can lose that objectivity, and make a change that you'll regret. 

Position Sizing 

Professional traders generally won't risk more than 1-2% of their portfolio in any 
given trade. So, if you have a $1,000,000 account, and your trading plan includes 
a 10% stop loss on each trade, you would never put more than $100,000 into any 
one position. (A 10% loss on $100,000 is equivalent to a 1% loss on $1,000,000). 
The 1% at risk benchmark can be difficult to achieve if you are a new trader with 
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a smaller portfolio and/or you set tighter stops, such as 3%. What most traders 
will do in that situation is realize that you will need to have more than 1% of your 
portfolio at risk on your trades, but you still need to set a reasonable percentage 
so that you don't end up taking a position that's larger than necessary. Also, as 
your portfolio grows, you should adjust your position sizing to strive for that 1% 
risk ceiling. 

Whatever you do, don't fall into the trap of taking a larger position due to a higher 
level of confidence on a given trade. No matter how clearly all the signs point to 
huge profits, you're going to be wrong almost as often as you're right. Good 
discipline will allow you to survive a string of consecutive losses and still live to 
trade another day. Failure to employ sound money management techniques 
when trading will eventually lead to an empty trading account. 
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FAQ’s 
 

What Is Rampage Trading? 

Rampage Trading utilizes cutting-edge technology by combining quantitative 
analysis, predictive analytics and other proprietary statistically backed formulas 
employed by top institutional traders and fund managers to bring you the next 
generation of trading software. Rampage Trading’s proprietary software 
algorithms deliver real-time Buy and Sell (Short) signals on time-tested winning 
strategies. The software works on all markets, including Stocks, Futures, ETF's, 
Commodities, Forex, Bonds or any other freely traded markets. Rampage 
Trading is universal, and works with any time frame including day trading, swing 
trading and position trading.  

What Markets Can I Trade? 

Rampage Trading works in every market, with every style of trading. Perfect for 
day traders, swing traders and position traders. It works in any market condition – 
bull or bear. Rampage Trading works in any time frame as well: Daily charts, 
weekly charts, monthly charts, range charts, minute charts or tick charts. 

How Does Rampage Trading Work? 

 Pick a stock, future, forex or any liquid market that you'd like to trade. 
Type in the symbol. 

 Choose your time horizon: Daily, weekly, monthly, range, tick, etc. 
Whenever you see a Buy or Sell (Short) signal, you decide whether or not 
you want to enter the trade. 

 Can it really be this simple? Absolutely! 
 Of course, there are a few finer points you'll need to learn along the way, 

but this is the simplicity of our software. 

How Does The Software Work? 

Rampage Trading targets clean, easy to see price reversal points at support and 
resistance levels carved out by the markets price action. Rampage Trading 
assists the trader in identifying trading opportunities by very clearly and 
graphically displaying color changes that correspond with changes in price, 
volume and trend. Blue is bullish (more buyers than sellers), Gold is neutral 
(price consolidation) and Red is bearish (more sellers than buyers). The price 
bars or candlesticks change colors to reflect these conditions. In an uptrend, 
there are more buyers than sellers and the price bars or candlesticks turn Blue. 
We Buy on Blue price bars or candlesticks. Gold price bars or candlesticks 
represent market indecision or price consolidation and no action is to be taken. In 
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a downtrend, there are more sellers than buyers and the price bars or 
candlesticks turn Red. We Sell (Short) on Red price bars or candlesticks. Our 
software will show you precisely where the balance of buyers and sellers begins 
to shift and a change of direction becomes imminent. 

You may also confirm each Buy or Sell (Short) signal with our proprietary trend 
algorithms represented by Blue or Red colored dots above or below price. A Blue 
dot below price represents a confirmed uptrend. A Red dot above price 
represents a confirmed downtrend. If the last trend algorithm is Blue in color and 
you receive a Buy signal, you may take the long trade. If the last trend algorithm 
is Red in color and you receive a Sell (Short) signal, you may take the Sell 
(Short) trade. Note that you may take the trade based solely on the Buy or Sell 
(Short) signal you receive without using the trend algorithms. However, we 
recommend the Buy or Sell (Short) signal be in agreement with the last trend 
algorithm colored dot (Blue is bullish while Red is bearish). Values of our 
proprietary trend algorithms (Blue or Red colored dots above or below price) 
represent key support/resistance areas and are used as protection stops if the 
market turns against our position. 

Who Are We? 

Over the last decade, our team began extensive research into the area of 
algorithmic/automated trading with the goal of taking a successful discretionary 
trading strategy and making it as autonomous as possible. With the help of some 
of the brightest minds on Wall Street and armed with a knowledge of statistically 
based behavioral research, the Rampage Trading team was able to develop 
multi-tiered algorithms that identify significant pre-conditions in price action for 
preeminent stock moves. This program, based on aggregate algorithms, in 
combination with typical triggers for entry, risk management concepts, and 
proper exit techniques, surpassed expectations and lead to the development of 
Rampage Trading. 

Why Share Our Software? 

a. We will only release our product to 100 retail traders. 
b. We trade this for ourselves and we are frequently contracted by top Wall 
Street firms to teach our methods. 
c. Institutions, Brokers, Money Mangers, please email us for disclosure 
agreements. 
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How Can I Get Started With Rampage Trading? 

If you are a current NinjaTrader user, simply go to our purchase page and follow 
the simple instructions to register, download and install Rampage Trading for the 
NinjaTrader package. Otherwise, you must first open a NinjaTrader account. 

What Is Required To Use Rampage Trading For 
NinjaTrader? 

1. The NinjaTrader software package and an active NinjaTrader account. 
2. Access to real-time or historical data feed. 
3. The Rampage Trading software package. 

How Can I Get NinjaTrader? 

To register for and download NinjaTrader, please go HERE: 
http://www.ninjatrader.com/webnew/download_trading_software.htm 

How Does Rampage Trading Help Me Decide When To 
Enter And Exit The Market? 

Our algorithms will keep you in each trade for as long as the momentum 
continues in the same direction. Exits can be made at pre-selected profit targets 
or you can exit or reverse at the next turn. This, again, is how the software is 
designed to fit your personal trading style. Rampage Trading let's you see what is 
going on in the market "right now," so you can simplify your trading decisions. 
  

Does Rampage Trading Work in All Markets? 

Yes! 

Where Can I Learn More About Rampage Trading? 

Please visit our “Members” section on our website: 
 
http://www.rampagetrading.com/members 

 

 

 

http://www.rampagetrading.com/members
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What If I Have Questions Or A Problem? 

Our offices are open each trading day during market hours. You can email 
support at any time. You will receive a response within 24 hours. Please 
remember that we are traders and we may have to get back to you later in the 
day. 

Is There Technical Support Available At Rampage Trading? 

Yes. The Rampage Trading team is always here to answer your e-mail 
questions. We want Rampage Trading to help make you the best trader you can 
be. 
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Setting up Rampage Trading for NinjaTrader Version 7: 

Q. What do I need to do to get started? 
 
A. Download NinjaTrader which can be found here: 
http://www.ninjatrader.com/download-registration 

Once you have installed NinjaTrader, you will need a data feed. Please refer to 
the NinjaTrader download page to see what data feeds are supported. 
http://www.ninjatrader.com/Support#Help-Guides 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

andrey
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Account Connections 
 
Within the NinjaTrader Control Center window, select the Tools menu followed by 
the Account Connections menu item. This will launch the Account Connection 
Set Up window. A connection is where you set up your user name, password and 
any relevant information that allows you to establish a connection to your 
connectivity provider which is your broker and/or data feed service.  
 

 
 

How to create an Account Connection 

 

Within the Account Connection Set Up window you can establish a connection, 
add a connection, change a connection or remove a connection. The following 
steps use eSignal as the connectivity provider. This provider is used for 
demonstration purposes. 
  
To create an Account Connection: 
  
1. Open the Account Connection Set Up window by going to the Tools menu 
within the Control Center and selecting the menu item Account Connections. 
2. Press the Add button to launch the connection wizard. 
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3. After pressing the Next button, you will be prompted to supply: 

 User defined connection name (Only use alphanumeric characters in the 
connection name). 

 Select the connectivity provider. 

 Optional back up data feed connection. 

 Historical Data Options (visibility of these options are dependent on the 
provider and your license). 

 Optionally select "Connect on startup" to automatically connect to this 
connection when NinjaTrader is started. 

 Note: Please test and ensure your connection is working as expected 
before using this option as it is possible to input incorrect credentials 
which could prevent the startup of NinjaTrader. 
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4. After pressing the Next button, you will be presented with provider specific 
parameters that you must enter in order to establish a connection. Each different 
provider may have different options. For specific information relative to your 
connectivity provider, please see the Connection Guide: 
http://www.ninjatrader.com/Support.php#Help-Guides 
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5. Once you have entered in all of the required connectivity information and 
pressed the Next button, your set up information will be presented to you at 
which time you must press the Finish button.  
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The newly created connection will be displayed in the Account Connection Set 
Up window and can be connected to by selecting the File menu from the Control 
Center then selecting the Connect menu item and left mouse clicking on the 
account connection you have created. 
 

Multiple Connections 
 
NinjaTrader supports multiple simultaneous connections to different connectivity 
providers and in some cases, to the same connectivity provider allowing you to: 
  

 Connect to and trade through multiple brokers simultaneously. 

 Connect to your broker and your data feed provider simultaneously. 
 
Primary and Secondary Data Feeds 
 
You may or may not want to use your brokers data feed as your primary data 
feed. For example, you may want to use eSignal as your primary data feed and 
your broker as back up. If this is the case, connect to eSignal first and then 
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establish your broker connection. Whenever you request data for a particular 
market, NinjaTrader will request data from the eSignal connection first and then 
your broker connection second if a market data request fails from eSignal. During 
the connection creation process, you also have the ability to assign a back up 
data feed connection. By doing so, you tell NinjaTrader to fail over to the back up 
data feed if the primary feed is disconnected. This will only work if the back up 
data feed connection is connected. 
  
Connection Order is Significant 
 
If you are establishing multiple connections that overlap in their provided market 
data services, the connection order you establish is critical. NinjaTrader will 
check for required market data services in the order your connections are 
established. 
  
For example: 
  
BrokerA - Provides real-time market and historical data.  
BrokerB - Provides only real-time market data. 
  
If you connect to BrokerA first and BrokerB second, when requesting market data 
NinjaTrader will request the data stream for both real-time and historical data 
from BrokerA even if you trade against BrokerB. It is possible you want to use the 
real-time market data from BrokerB (you perceive it to be faster) then you should 
connect to BrokerB first and BrokerA second. NinjaTrader is smart enough to 
realize that although it uses BrokerB for real-time data it will request historical 
data from BrokerA. 
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Before you begin the installation process, please close NinjaTrader Version 7. 

Instructions: 

Step 1. Download the indicator from the executable file link sent to your provided 
email address after purchase. 

Step 2. Before you begin the installation process, please ensure that NinjaTrader 
Version 7 is closed. If NinjaTrader version 7 is open, the setup will not run 
correctly. 

Step 3. After clicking on the executable file link, Select Run>Select Run 
Again>Select Next>Select Install>Select Finish. 

Step 4. After closing the Install Wizard, you may now start NinjaTrader version 7. 
Connect to your datafeed via Control Center (File> Connect>Datafeed Name – 
Please check the NinjaTrader Version 7 online manual to create a new datafeed 
or connect to an existing one). Then open an empty chart via Control Center> 
File> New> Chart or please proceed to Step 5 if you are already a NinjaTrader 
Version 7 user and have your charts setup. 

Step 5. After opening your chart, you can apply the newly installed RampageV7, 
RampageV7MTA, RVOL and RS Indicators by right-clicking the chart and 
selecting Indicators or simply pressing the CTRL + I combination. Scroll down the 
Indicator list and look for the newly installed RampageV7, RampageV7MTA, 
RVOL and RS Indicators. You will see the name RampageV7, RampageV7MTA, 
RVOL and RS. 

Step 6. Double click on the Indicator’s name (RampageV7), (RampageV7MTA), 
(RVOL) and (RS) to add it to the lower left area of the Indicators window. Please 
leave all settings as they are. After finishing, click “Apply” then “OK.” You will now 
be prompted to enter a license key (which you will receive in your Rampage 
Trading License Activation email). This license key is unique to you and your 
system allowing you access to the indicator. 

Step 7. Please format your chart by right clicking on your chart and selecting 
properties. This will bring up a new box where you can select your settings for 
your chart. Please visit the NinjaTrader Version 7 Help Guide for more 
information: 

NinjaTrader Version 7 Help Guide: 
http://www.ninjatrader.com/Support 

Best Trading, 

Rampage Trading 


